NOTICE

This document and the Sage 300 Construction and Real Estate Software MyAssistant software may be used only in accordance with the accompanying Innovative Software Design End User License Agreement. You may not use, copy, modify, or transfer the Sage 300 Construction and Real Estate Software MyAssistant software or this documentation except as expressly provided in the license agreement.

© 2016 Innovative Software Design. All rights reserved.
Table of Contents

Conventions Used in this Document ........................................................................................................... 5
Before You Begin ........................................................................................................................................ 6
Support and Training ................................................................................................................................. 6
Telephone Support .................................................................................................................................... 6
Sage Customer Portal ............................................................................................................................... 7
Education & Training .............................................................................................................................. 7
Release Notes ........................................................................................................................................... 7
Sage University .......................................................................................................................................... 7
MyAssistant YouTube Channel .................................................................................................................. 7
Local Business Partner ............................................................................................................................. 7

Chapter 1 – Back Up the MyAssistant Database ....................................................................................... 8

Chapter 2 – Upgrading the MyAssistant Server ....................................................................................... 10

Step 1 – MyAssistant Server Upgrade ................................................................................................. 11
Step 2 – MyAssistant License Agreement ........................................................................................... 12
Step 3 – Prerequisites for MyAssistant Server ................................................................................. 13
Step 4 – MyAssistant Software ........................................................................................................... 14
Step 5 – You Have Completed Upgrading the MyAssistant Server .................................................. 15
Step 6 – Start the MyAssistant Configuration Manager .................................................................. 16

Chapter 3 – MyAssistant Server Configuration ..................................................................................... 17

Read this section carefully: ................................................................................................................... 17
Step 1 – Welcome ................................................................................................................................. 18
Step 2 – Product Activation .................................................................................................................. 19
Step 3 – Database Connection ............................................................................................................. 20
Step 4 – Upgrade the MyAssistant Database .................................................................................... 21
Step 5 – Sage 300 CRE Data Folders ................................................................................................. 22
Step 6 – Notification E-Mail Account ................................................................................................ 23
Step 7 – Server Options ....................................................................................................................... 24

Upgrading the MyAssistant Drive Mapper ............................................................................................... 26

How do I know if I am using the Drive Mapper? ................................................................................ 26

Chapter 4 – Upgrading the MyAssistant Workstation(s) ........................................................................ 27

Step 1 – Welcome ................................................................................................................................. 28
Step 2 – MyAssistant License Agreement .......................................................................................... 29
Step 3 – Prerequisites for MyAssistant Workstation ..................................................................... 30
Step 4 – Install the Software ............................................................................................................... 30
Conventions Used in this Document

This document uses the following conventions:

- The names of screens, windows, fields, and other features displayed by the software are shown in **bold type**.
- Information you enter into the software is in **bold type**, as in the following example: Enter **Miscellaneous** in the **Amount Type** box.
- Names of keys are shown in capitals; for example, **ENTER**, **TAB**. A plus sign (+) between two key names indicates that you should press both keys at the same time; for example, **SHIFT + TAB**.
- The names of buttons you can click with your mouse are enclosed in **bold type**; for example, **[OK]** and **[Post]**.

**TIP:** Helpful information to make your experience better.

**NOTE:** This symbol draws your attention to information of particular interest, such as information not included in steps.

**CAUTION:** This symbol draws your attention to information that is important because it can help you avoid a costly or time-consuming error.

**IMPORTANT:** This symbol draws your attention to information that is of critical importance.
MyAssistant Upgrade Guide

This document steps you through the upgrading to and configuring Sage 300 CRE MyAssistant 16.1. If you are installing the MyAssistant software for the first time, please refer to the MyAssistant Installation Guide included in the MyAssistant installation files.

Upgrading the MyAssistant software consists of the following steps:

1. Upgrade the MyAssistant Server software.
2. Upgrade the MyAssistant database and confirm previous settings by completing the MyAssistant Configuration Wizard.
3. (Optional) Upgrade the MyAssistant Drive Mapper.
4. Upgrade MyAssistant on the desktop computers or Terminal/Citrix Servers where MyAssistant is used.

Upgrading the MyAssistant server should take approximately 30 minutes. Upgrading each MyAssistant workstation should take approximately 10 minutes.

**CAUTION:** MyAssistant 4.0 and higher can upgrade directly to MyAssistant 16.1. If you are running MyAssistant 3.x or earlier, upgrade to MyAssistant 4.2 before upgrading to MyAssistant 16.1. If you upgrade from an unsupported path you risk corrupting your MyAssistant data.

**Before You Begin**

- Determine the computer where the MyAssistant server software is currently installed. It is most likely on your Sage 300 CRE server.
- Log in to the server using the Windows username that was most likely used to install and activate the MyAssistant server. Most often this is a Windows Administrator account.
- Create a backup of your MyAssistant database prior to upgrading the software.
- Ensure the latest Microsoft Windows and Microsoft Office updates have been installed. Installing the High Priority updates is recommended.
- Confirm all machines where MyAssistant will be installed are running Sage 300 CRE 16.1 or later, including the MyAssistant Server.

**TIP:** Restart the MyAssistant server prior to performing the upgrade. This will complete any Windows or other software updates where a restart is required.

**Support and Training**

**Telephone Support**

When you would like to speak to a customer support analyst directly, call us at 800-551-8307. Telephone support is available Monday through Friday from 6 a.m. to 5 p.m. Pacific Time with the following exceptions:

- Every Thursday from 2 p.m. to 3 p.m. Pacific time (closed for customer support staff meetings)
- Standard United States holidays
- Quarterly company meetings
Sage Customer Portal

You may log on to the Sage Customer Portal at: https://customers.sagenorthamerica.com/irj/portal/anonymous/login.

The portal provides access to the following services:
- Knowledgebase: Find answers to your questions, access downloads, and subscribe to your favorite articles. This service is available online 24/7.
- Live Chat: Chat online with a customer support analyst, a great option for quick questions. Chat hours are Monday through Friday from 6 a.m. to 3 p.m. Pacific Time, with the same exceptions as telephone support.
- Online Support Request: If you have a question or an issue that is not urgent, you can submit an online support ticket. A customer support analyst will contact you during regular telephone support hours.

Education & Training

Release Notes
To learn about what's new in Sage 300 CRE MyAssistant 16.1, refer to the Sage MyAssistant 16.1 Release Notes included in the MyAssistant installation files.

Sage University
Sage University offers both recorded and live training sessions. Visit SageU.com for currently available and upcoming classes.

How to access MyAssistant training options in Sage University:
2. Click [Customer Training] and select your Sage 300 Product from the list.
3. In the page that opens, click [Product Training] on the left side of the screen.
4. Click [MyAssistant] in the list that opened.
5. Select either [Realtime Learning] or [Replay Learning] and review the available options in each.

How to access Complimentary MyAssistant Training in Sage University:
2. Click [Customer Training] and select your Sage 300 Product from the list.
3. Click [Complimentary Training] on the left side of the screen.
4. Review the list of complimentary classes for a MyAssistant option.

MyAssistant YouTube Channel
The MyAssistant YouTube channel offers a variety of MyAssistant training videos. Subscribe to the MyAssistant YouTube channel to be notified when new videos are added.

How to access the MyAssistant YouTube channel:
1. Enter www.YouTube.com/MyAssistantTraining
2. The channel will open with all available videos listed.
3. Click on a video to watch.

Local Business Partner
Contact your local Business Partner to learn what types of MyAssistant training they can provide.
Chapter 1 – Back Up the MyAssistant Database

Before upgrading your MyAssistant software, it is important that you backup your current MyAssistant database.

1. Log in to the MyAssistant server using the Windows account used to install and activate the MyAssistant Server. This is often an Administrator account.

2. Open the MyAssistant Configuration Manager using the icon on your desktop (pictured left), or by navigating to Start > All Programs > Sage > MyAssistant > MyAssistant Configuration Manager

3. Click the tab labeled MyAssistant Database Connection

4. Click [Backup Database...] (highlighted below)
5. In the new window that opens, select the location where the backup of the database will be stored. A default location will be prefilled, but can be changed by typing into the text box or using the [...] button to the right of the text box.

6. After selecting a backup file location, click [Backup MyAssistant Database]

7. When the process has completed, a message will appear that states the backup was successful, and will list the folder location where the backup was saved.

8. After finishing, click [OK].

Now that your MyAssistant database has successfully been backed up, continue with the upgrade of your MyAssistant software.
Chapter 2 – Upgrading the MyAssistant Server

Perform the following to initiate the MyAssistant Server upgrade.

1. (Optional) Log on to your Sage 300 MyAssistant server with a Windows user that has Administrator or Unlimited permissions. You do not need to do this step if you already logged in as an administrator to back up your MyAssistant database.

2. Confirm that you have closed all applications and disabled any anti-virus or Firewall software that may be running on the server.

3. Using the link provided by Sage Software, download the MyAssistant installation files and save the .ZIP file to a folder on your machine. Consider saving the .ZIP file to a shared folder so it is accessible from all workstations where MyAssistant will be installed.

Perform the following to initiate the MyAssistant Server Upgrade:
   a) Open the location of the downloaded MyAssistant Installation files.
   b) Unzip the files to a folder in the same shared folder the .ZIP file was placed.
   c) Open the location of the unzipped MyAssistant installation files and double click autorun.hta

4. The Sage 300 CRE MyAssistant Installation hub will open:

   ![Sage CRE Installation Hub]

   Click [Install Server] to start the MyAssistant Server upgrade.
Step 1 – MyAssistant Server Upgrade

The MyAssistant Installation wizard displays once you have selected the type of install.

This wizard will guide you through the MyAssistant installation process. You may be asked to restart your system after installing prerequisites.

- Prerequisites
- MyAssistant

Before continuing installation, please close all applications (such as Microsoft Outlook, Virus Scanners, and Spyware Detectors), since they can interfere with the MyAssistant installation.

Click [Next] to continue.
Step 2 – MyAssistant License Agreement

You must accept the Innovative Software Design License Agreement to upgrade the Sage 300 CRE MyAssistant software. A complete copy of the License Agreement is provided with the MyAssistant installation files.

If you agree to the terms of the License Agreement, check the I accept the terms in the license agreement checkbox and click [Next] to continue.
**Step 3 – Prerequisites for MyAssistant Server**

This window displays the prerequisite software, if any, that MyAssistant will need upgrade.

![Prerequisites Window]

**IMPORTANT:** It is highly unlikely that you will encounter this screen when upgrading from a previous version of MyAssistant – the most likely scenario for seeing this screen would be if you have a custom configuration of your SQL Server. If you do see this screen, it is highly recommended you check the box next to “Do not install SQL Server Express.”
Step 4 – MyAssistant Software

In this step you will determine where the updated MyAssistant Program Files will be installed on your server.

Accept the default location or use the [Browse] button to specify a different location. It is recommended that you accept the default unless you have previously saved the MyAssistant Program Files in a custom location.

Click [Next] to install the updated MyAssistant Server software.
Step 5 – You Have Completed Upgrading the MyAssistant Server

Congratulations, you have completed upgrading the MyAssistant Server.

Click [Finish] to close the wizard and have the option to continue to the Configuration Manager.

NOTE: You must step through the Configuration Manager on the server before upgrading MyAssistant on any Workstations.
Step 6 – Start the MyAssistant Configuration Manager

After clicking Finish, you will be prompted to start the MyAssistant Configuration Manager.

Click [Yes]. Continue to Chapter 4 to walk through the MyAssistant Server Configuration Manager.
Chapter 3 – MyAssistant Server Configuration

This chapter walks through MyAssistant Server Configuration Manager, where you will upgrade your MyAssistant database and verify that all settings are still accurate. Configuring the server must be completed before upgrading MyAssistant on any Workstations.

Read this section carefully:

You will complete the following steps to configure the MyAssistant Server:

1. Upgrade your MyAssistant database.
2. Confirm the prefilled file paths for Sage data folders
3. Confirm the prefilled Mail Server settings for sending emails with MyAssistant
4. Confirm the MyAssistant Server settings

NOTE: Reactivating the software and stepping through the Configuration Manager on the MyAssistant Server will take approximately 10 minutes.
Step 1 – Welcome

If the MyAssistant Configuration wizard isn’t started, open it with the desktop icon or by following this path: Windows Start > All Programs > MyAssistant > MyAssistant Configuration Manager.

Only check Show Advanced Options if you are using a Web Proxy Server, or would like to define new Microsoft SQL Server credentials to access MyAssistant data. It is highly recommended you do not change SQL Server credentials, as those used by the MyAssistant Server prior to upgrade are remembered.
Step 2 – Product Activation

In most cases, MyAssistant will remember the Customer Number and Server Product Key previously used to activate the MyAssistant Server.

If you use a Web Proxy Server, check the box displayed under the Server Product Key field and verify that the information entered is accurate.

**NOTE:** The **Web Proxy Server** checkbox will only appear if you selected Show Advanced Options in the Welcome Screen (Step 1).
Step 3 – Database Connection

**NOTE:** This step will only be available if you click [Show Advanced Options] in the Welcome step.

**CAUTION:** Making changes in this step can break the connection to the MyAssistant database. Modifying these fields requires advanced knowledge of SQL Server database engines. It is highly recommended that you do not make any changes in this step when upgrading your MyAssistant Server.

This step gives you access to the server name, SQL Server credentials, and SQL Instance and Port Number MyAssistant uses to connect to the Database.

This step will have all previously entered information prefilled.

Click [Next] to continue.
Step 4 – Upgrade the MyAssistant Database

MyAssistant will perform the necessary steps to upgrade your database.

Click [Next] to upgrade the database.
Step 5 – Sage 300 CRE Data Folders

Verify that the information in this step is still accurate. These are the data folders MyAssistant will be able to monitor, and the Sage 300 CRE credentials MyAssistant will use to access the data.

Click [Next] to continue. If there is more than one data folder entered, you will be prompted to select which folder’s Database Customizations to import. If there is only one data folder specified, Database Customizations will be imported automatically.

If the Sage 300 CRE password entered above is set to expire, a warning message will appear. When the password does expire, you will need to reopen the MyAssistant Configuration Manager and enter the new password in this step. Updating the settings for this User account in Sage so the password never expires is recommended.
Step 6 – Notification E-Mail Account

Verify your mail server settings are still accurate, or update them if they have changed.

Click [Next] to continue.
Step 7 – Server Options

This final step is used to determine a variety of settings around the MyAssistant Server.

**Daily Summaries:** MyAssistant Daily Summary email messages are used to send each recipient their notifications across several Tasks in one email message. See the MyAssistant User Guide for more information. This time should be after all of your daily Tasks have run.

**Send Errors To:** Someone to be notified when MyAssistant encounters an error. It is recommended to send error messages to the primary MyAssistant user.

**Save MyCommunicator Email Messages:**
Sage MyCommunicator for Outlook allows you to centrally track users’ email correspondence related to your business. In addition to creating a record of business-related emails, a copy of the mail messages can be saved and linked to your Sage data (e.g. Jobs, vendors, customers, etc.). To enable this function, check the box in this section and click [Browse...] to select a folder location.

**Running Tasks and Sending Service Settings:**
MyAssistant runs Tasks, sends emails and updates Sage data with MyCommunicator via background processes (i.e. Windows Services) on the server. These processes are now scalable to increase performance, and auto-correct in the event of a hang.
These MyAssistant Services (named ISDAdminTaskService and ISDAdminSenderService) start other processes named “TaskRunner\*32,” which each take 30-50Mb of memory when idle. Many variables affect the system resources used when Tasks run and emails are sent, including:

- The available server memory
- Disk drive performance
- Other server demands at the time the MyAssistant Tasks are run. For example, running Tasks at night may allow additional server resources to be dedicated to MyAssistant.

Perform the following to determine the optimal number of processes:

- Complete the MyAssistant server configuration with the default settings and the MyAssistant workstation installation.
- Activate two MyAssistant Tasks you will regularly use.
- Use the Windows Task Manager and the Resource Monitor to track server memory usage and disk queue lengths when both Tasks are run concurrently.
- Open the MyAssistant Configuration Manager and increase or decrease the number of processes based on available server resources.

Click [Finish] to close the MyAssistant Server Configuration Wizard.

Once the Configuration Wizard is closed, the Server portion of the MyAssistant installation is complete. Continue to Chapter 5 to install the MyAssistant Workstation.
Upgrading the MyAssistant Drive Mapper

If you use a Mapped Drive (e.g. drive letter “T:”) to access your Sage 300 CRE data or Program Files, you need to upgrade the MyAssistant Drive Mapper. The MyAssistant Drive Mapper is used by the Windows Service that runs MyAssistant Tasks to access your Sage 300 CRE database or programs.

How do I know if I am using the Drive Mapper?

Perform the following:
1. Log on to the server where the MyAssistant server is installed
2. Open Windows Explorer
3. Go to the folder where the MyAssistant Program Files are installed. If you accepted the default location when installing the software, the MyAssistant Program Files will be in the following location:
   C:\Program Files (x86)\Innovative Software Design\MyAssistant

If this file exists, you are using the MyAssistant Drive Mapper and it will need to be updated in all three locations (the MyAssistant, Task Service and Sender Service program folders).

⚠️ CAUTION: The MyAssistant Drive Mapper must be used if you are using mapped drives to access your Sage 300 data files or Program Files. If you are using UNC paths and do not use any mapped drives, you do not need to use the Drive Mapper tool.

Perform the following to upgrade the MyAssistant Drive Mapper:

1. Log on to the computer where the MyAssistant Server is installed using the account that activated the MyAssistant Server. Often this is an Administrator account.

2. Open the folder containing the MyAssistant installation files. This will be a location you selected when saving the files. There is no default location.

3. Using Windows Explorer, copy and replace the file InnovativeSoftwareDesign.MyAssistant.DriveMapperCommand.dll from the Tools > DriveMapperCommand folder in the MyAssistant installation files to the folder where the MyAssistant software has been installed. If you accepted the default location when installing the MyAssistant software, this location will be C:\Program Files\Innovative Software Design\MyAssistant.

4. The InnovativeSoftwareDesign.MyAssistant.DriveMapperCommand.dll also needs to be placed in the following locations:
   a. Program Files\Innovative Software Design\MyAssistant\Sender Service
   b. Program Files\Innovative Software Design\MyAssistant\Task Service

5. Once you have replaced this file, restart the ISDAdminTaskService and ISDAdminSenderService from the Windows Services window. Follow the instructions below to do this.
   1. Click to open the Start menu and click [Run]
   2. In the Run box type services.msc to open the Windows Services window
   3. Look down the list for ISDAdminTaskService and ISDAdminSenderService
   4. Restart both of these services.

The MyAssistant Drive Mapper tool is now upgraded.
Chapter 4 – Upgrading the MyAssistant Workstation(s)

**IMPORTANT:** If you are upgrading a Terminal or Citrix Server, please go to Chapter 6.

Perform the following to initiate the MyAssistant Workstation upgrade.

1. Log on to your Sage 300 MyAssistant workstation as the Windows user who has MyAssistant activated.

2. Confirm that you have closed all applications and disabled any anti-virus or Firewall software that may be running.

3. If accessible from the Workstation, open the same folder of unzipped MyAssistant install files used to upgrade the MyAssistant Server. If not, perform the following to initiate the MyAssistant Workstation Upgrade:
   a) Download the MyAssistant Installation files and open the folder they were downloaded to.
   b) Unzip the files to a folder on the local drive of the Workstation.
   c) Open the location of the unzipped MyAssistant installation files and double click autorun.hta

4. The Sage 300 CRE MyAssistant Installation hub will open.

Select [Install Workstation] to perform a MyAssistant Workstation upgrade.
Step 1 – Welcome

When you select Workstation Install on the MyAssistant splash screen, the Setup Workstation wizard will appear:

Click [Next] to continue.
Step 2 – MyAssistant License Agreement

Read and accept the Innovative Software Design End-User License Agreement. You must accept the Innovative Software Design License Agreement to use the Sage 300 CRE MyAssistant software.

Click [Next] to continue.
Step 3 – Prerequisites for MyAssistant Workstation

The next window displays the prerequisite software that MyAssistant may need to upgrade. If there are no software updates necessary on the workstation, the Setup Workstation Wizard will skip this step. Once all prerequisites have been installed, click [Next] to continue with the MyAssistant Workstation Install.

Step 4 – Install the Software

Select the location where the MyAssistant Program Files will be installed.

Accept the default location or use the [Browse] button to specify a different location. It is recommended that you accept the default unless you have previously saved the MyAssistant Program Files in a custom location.

Click [Next] to install the updated MyAssistant software on the workstation.
Step 5 – You have Completed Installing MyAssistant

Congratulations. MyAssistant has been successfully upgraded on this machine.

Click [Finish] to close the setup wizard.
Chapter 5 – MyAssistant Workstation Configuration

**NOTE:** In most cases, MyAssistant remember prior settings and open automatically. However, in some instances you may be required to complete the User Configuration Wizard.

**Step 1 – Welcome Screen**

Double click on the MyAssistant icon on the desktop to open the MyAssistant Configuration Wizard.

If there is not a shortcut on the desktop, follow the path below to open MyAssistant:

Start > All Programs > MyAssistant (File) > MyAssistant
Step 2 – Product Activation

All settings in this step should be prefilled from the last time MyAssistant was activated on this computer. Confirm MyAssistant is activated, and that any Web Proxy Settings are up-to-date.

![MyAssistant User Configuration Wizard](image)

**NOTE:** The Web Proxy Server connection fields will only be available if you clicked [Show Advanced Options] in the Welcome step.

Click [Next] to continue.
Step 3 – Entering Sage 300 CRE Data Folder Information

Confirm the Sage login credentials and Sage data folder paths are still accurate.

Click [Next] to continue.
Step 4 – User Profile

This step shows the personal information for the Windows user on this workstation, which should prefill.

Click [Finish] to close the wizard and open MyAssistant.
Chapter 6 – Upgrading a Terminal Server

CAUTION: This chapter is written for clients who will be running the MyAssistant Server and at least one MyAssistant User on a Terminal or Citrix Server.

What is Involved
Perform the following to upgrade MyAssistant on a Terminal or Citrix Server:
1. Log on to the Server as the Windows user that activated the MyAssistant Server.
2. Run the MyAssistant Server installation to upgrade.
3. Confirm the settings in the Server Configuration Manager.
4. Log on to the machine with the Windows user who uses MyAssistant.
5. Open the MyAssistant user Application.
6. If needed, confirm previous settings for user configuration.

Before Upgrading
Before MyAssistant can be upgraded on any accounts other than the administrator, permissions must be given to specific files. The default paths have been provided for your convenience below, however they may vary slightly.

If on Windows 2008:
- C:\Program Data
- C:\Program Files\Innovative Software Design
  OR
- C:\Program Files(x86)\Innovative Software Design

If on Windows 2012:
- C:\Program Data
- C:\Program Files\Innovative Software Design
  OR
- C:\Program Files(x86)\Innovative Software Design

IMPORTANT: Permissions need to be given to these folders prior to activating any MyAssistant users on this machine.

Upgrading the MyAssistant Server
Complete to Chapters 1 through 4 for upgrading the MyAssistant Server. When you have completed Chapter 4, return to this Chapter to activate the MyAssistant User Software on this Terminal or Citrix Server.

Activating the MyAssistant Workstation
Once the MyAssistant Server is upgraded and configured, log onto the Terminal or Citrix Server as the Windows user who will be using the MyAssistant software.
- If there is a MyAssistant icon on the desktop, double click to open the User Configuration Manager.
- If there is not an icon on the desktop follow this path:
  Start > All Programs > Sage > MyAssistant (folder) > MyAssistant
When the User Configuration Manager is open complete the steps in Chapter 6 to activate the MyAssistant workstation.
Chapter 7 – Test the Upgrade

Confirm MyAssistant is working properly by testing the following:

**Access Sage 300 CRE Data**

1. Open the MyAssistant Designer software from a MyAssistant Workstation.
2. Open an activated MyAssistant Task.
3. Move to the Email step in Task Setup.
4. Expand the very first record in the list of available Sage 300 CRE database records (on the right side of the window).
5. Right click on the first field and select [Browse Data].
6. The data contained in the field should be displayed in the Browse Data window.

**Troubleshooting**

1. If clicking [Browse Data] returns an error:
   a. In the main MyAssistant window, select File > [Options] to open the Options window.
   b. Move to the Sage 300 CRE Data Folder step.
   c. Click [Test Connection] to confirm that the Sage 300 CRE credentials entered are able to access the Sage data. If the test fails, update the credentials.
   d. Contact Sage Support if the credentials are correct but you still receive an error when browsing.
2. If clicking [Browse Data] results in a blank Browse Data window, that field may not have data. Try another field in the same record.

**Run Tasks and Receive Email Messages**

1. Open the MyAssistant software from a MyAssistant Workstation.
2. Browse to an activated Task. If possible, select a Task with an attached Crystal Report that is being sent to you (edit the recipient list as needed).
3. Right click on the Task and click [Run and Send].

**Troubleshooting**

1. If the Task doesn’t finish running:
   a. Log onto the MyAssistant Server.
   b. Open the Windows Services window (Start > Run > type: Services.msc).
   c. Look for the ISDAdminTask and ISDAdminSender services. Confirm both are started.
2. If the Task finishes running but an email is not received:
   a. Click the Reports tab, then [Notifications Not Sent]. If you see Notifications, click the Refresh button once every thirty seconds until you see “No notifications to send.”
   b. If you still don’t receive an email:
      a. Open the Windows Services window (Start > Run > type: Services.msc).
      b. Look for the ISDAdminSenderService. Right click on the service and select [Properties].
      c. Click the [Log On] tab.
      d. Select [This account] and enter a Windows user that is associated with a person who is an administrator in the Sage 300 CRE software.
      e. Click [OK] and then restart the Service.

**Conclusion**

This completes the upgrade of the Sage 300 CRE MyAssistant software. The next step is to learn your way around the updated software. Please refer to the User Guide for information on using MyAssistant.